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Abstract   

Numerous pathological disorders with widely differing origins and characteristics can affect the human jaws. These lesions 

can range from benign, but locally aggressive, lesions like ameloblastoma and odontogenic myxoma, to extremely destructive, 

potentially fatal lesions like malignant squamous cell carcinomas and osteosarcomas. The preferred method for managing these 

aggressive lesions is radical resection with suitable safety margins, ideally with immediate reconstruction whenever possible. It is 

of utmost importance that the surgeon finds the correct balance between being aggressive enough to ensure the removal of all tumor 

cells, and conservative enough to minimize the sacrifice of healthy tissue. The introduction of surgical guides in the field of 

maxillofacial surgery improved the accuracy of the operations and saved surgical time. The aim of this paper is to provide a highly 

detailed step by step guidance on the analysis, treatment planning, designing, and manufacturing of tailor-made resection guides 

using two sets of different software’s. A case report will then be presented showing the usage of a resection guide designed with 

this method.  
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1. Introduction 

The mandible can be affected by a myriad of 

pathological conditions, with widely varying origins and 

characteristics. These lesions may be as innocuous as simple 

small odontogenic granulomas and cysts of inflammatory 

origin, to benign, but locally aggressive lesions as 

ameloblastoma and odontogenic myxoma, ending with 

widely destructive, life-threatening lesions as malignant 

squamous cell carcinomas and osteosarcomas [1]. For the 

later groups, radical mandibular resections with appropriate 

safety margins, preferably with immediate reconstruction 

when applicable, is the technique of choice for management 

of these severe cases [2]. For the past 20 years, the advent of 

CT technology, and the following advances in computer 

science, have come together to create the field of Computer-

Assisted Surgery (CAS), and incrementally change our 

profession forever. Virtually, all fields of oral and 

maxillofacial surgery have been touched by CAS, including 

implantology, traumatology, orthognathic surgery, 

congenital deformities, and of course, pathologies requiring 

resection/reconstruction surgeries [3-4]. In 2015, Wilde et al. 

published a multicenter study on 30 patients receiving 

computer-guided resections using “keyhole” resection guides 

and reconstruction using patient specific implants. They 

concluded that “Mandibular reconstruction with PSMPs 

(Patient Specific Mandibular Reconstruction Plates) offers a 

broad range of opportunities and benefits compared with 

standard procedures and should be preferred where time and 

resources allow [5]. Hwang et al., in 2020 introduced tailor-

made non-linear resection guides and found that to be an 

equally safe less invasive option for mandibular resections 

[6].  

However, in most published reports, the surgical teams 

depend on third party companies, and web meetings with 

International Journal of Chemical and Biochemical Sciences 
(ISSN 2226-9614) 

 

Journal Home page:www.iscientific.org/Journal.html 

 

© International Scientific Organization 
 

mailto:ahmadbaha286@gmail.com
http://www.iscientific.org/Journal.html


International Journal of Chemical and Biochemical Sciences (IJCBS), 25(17) (2024): 34-37 

 

Hany et al., 2024     35 
 

biomedical engineers to virtually plan the surgical 

procedures, design the cutting and drilling guides and custom 

plate, manufacture them, and ship them for delivery. This 

adds time and financial constrains to the treatment plan, and 

deprives the surgical team of significant insights the could’ve 

made had they planned the case themselves [7]. The aim of 

this paper is to provide a highly detailed step by step guidance 

on the analysis, treatment planning, designing, and 

manufacturing of tailor-made resection guides using two sets 

of different software’s, one paid, and another completely free, 

so that surgical teams can alleviate these concerns, by the 

means they find best-suited to their situations. A case report 

will then be presented showing the usage of a resection guide 

designed with this method. 

 

2. Methods 

The first software package comprises InVesalius and 

Autodesk Meshmixer. These are completely free softwares 

available for download from their websites, 

https://www.cti.gov.br/invesalius and 

https://www.meshmixer.com respectively. InVesalius is a 

medical imaging program for 3D reconstruction, utilizing 

DICOM files from MSCT, CBCT, MRI, or any other imaging 

modality. The steps are as follows: 

 

● Open InVesalius 3 software, click on “Import 

medical images” and browse for the DICOM files of 

the MSCT data of the patient, let it load, then click 

“Import”. 

● From the “Create new mask” menu, select the set 

threshold values for Bone, or manually edit them to 

best represent the patient’s hard tissues. 

● Use the “manual edition” tool and the Erase function 

to manually separate the mandible from the rest of 

the scan in all slices, then select “Create surface”. 

● You will notice a 3D render of the mask appearing 

in the volume window. From the “Configure 3D 

surface” tab, choose the “select region of interest” 

tool, and click on the mandible on the Volume 

window. All unconnected volume sets should 

disappear, and you will be left with a new surface 

comprising only the mandible. 

● Create a new mask for the lesion. Manually set the 

threshold so that the upper and lower limits are the 

maximum values, and the mask is mostly empty. 

Use the manual edition tool, this time with “Draw” 

and trace the boundaries of the lesion in all slices. 

● Repeat the previous steps, so that you now have two 

surfaces, one for the Mandible, and one for the 

Lesion. Select both of them, choose the “Export 

data” option, “Export 3D surface”, and choose the 

destination for the STL files. This concludes the role 

of InVesalius 3 in this workflow.  

 

Meshmixer is a software for working with triangle 

meshes, cleaning up CAD files, and designing and preparing 

3D objects for 3D printing. The steps of using it are as 

follows: 

● Open Meshmixer and Import the Mandible and 

Lesion STL files exported from InVesalius. A 

prompt will ask if you would like the software to 

shift their position. You should decline, in order to 

keep the DICOM Coordinates of the objects 

unchanged, to import them back and superimpose 

them on the CT scan, should you feel the need to. 

● Use the Inspector tool in the Analysis tab to fix any 

problems with the meshes. Use the “Make Solid” 

tool in the Edit tab to fill out any voids in the interior 

of your objects. The combination of these two tools 

simplifies the meshes and makes them easier to 

work with and calculate more complex operations. 

It is therefore recommended they are repeated 

throughout this workflow. 

● Use the Select tool and mark the entire surface of the 

Lesion object. Then select “Edit” from the pop-up 

menu and choose “Offset”. In the distance, write in 

the recommended safety margin for the specific 

lesion to be excised. For Ameloblastoma for 

instance, safety margin is recommended to be 15 

mm. 

● Duplicate the Mandible object, and repeat the 

previous step for the duplicate object, only this time, 

setting the offset to 2mm. which will be the 

thickness of the resection guide. 

● Select the Mandible 2mm Offset object, then press 

the “Shift” key and also select the Lesion Offset” 

object. From the Edit menu, select the “Boolean 

Difference” option. 

● From the Select menu, mark the area of the guide 

shell you want to keep acting as the surgical guide, 

then choose “Modify” and “invert”. Press Delete to 

remove all the selected areas. 

● If provided by the manufacturer, you can import an 

STL file for the screws used to fix the guide or 

drilling for a Patient Specific Implant.  You can also 

drop a cylinder from the “Meshmixer: menu and 

enter the dimensions of the screws you plan to use. 

Use “Boolean Difference” tool as described earlier 

to incorporate the screw holes within the guide. 

● Export the final guide in STL format, and it is now 

ready to be printed using any desktop 3D printer. 

 

The second software package comprises Mimics 

Innovation Suite and Materialise 3-matic Medical softwares 

by Materialise. These are paid, state of the art software 

packages for Virtual Surgical Planning in various medical 

fields. More information can be found in their website, 

https://www.materialise.com. The steps are as follows: 

 

● The DICOM files are imported into Mimics Medical 

19.0 software. 

● Using the “Thresholding” tool, the range of 

Hounsefield Unit sets is chosen to highlight the 

mineralized structures and separate them from the 

rest of soft tissue structures in the scan creating a 

new mask. 

● Using the “Split Mask” tool the mandible and the 

skull are separated into a separate mask. 

● Using the “New Mask” tool, a new mask is created. 

Both the minimum and maximum threshold values 

are set to the maximum to create an essentially 

empty mask. Using the “Multiple Slice Edit” and 

“Region Growing” tools, the extent of the lesion is 

traced manually. 

https://www.cti.gov.br/invesalius
https://www.meshmixer.com/
https://www.materialise.com/
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● Using the “Calculate 3D” tool on the new masks, a 

3D rendering of the facial mineralized structures and 

the lesion are created. 

● The Standard Tessellation Language (STL) files are 

then imported into 3-matic Medical 14.0 Software 

for further preparation. 

● The models are refined using the “Fix Wizard”, 

“Smoothing” and “Wrap” tools. 

● The Midsagittal Plane (MSP) is constructed using 

the Anterior Nasal Spine, Nasion, and Basion points. 

Using the Mirror tool, the mandible is mirrored 

around the MSP. “N-Point Registration” and 

“Global Registration” Alignment tools are used to 

better align the mirrored Mandible to the original 

Mandible. 

● Using the “Offset” tool in the Design menu, the 

Lesion object is expanded depending on its nature to 

visualise its safety margin. For example, in a case of 

Ameloblastoma, the offset should be set to 10-15 

mm. 

● Using Boolean Operations, the Lesion Offset can be 

subtracted from the original mandibular STL file to 

create the remaining bones after simulated resection, 

and it can also be intersected with the mirrored 

mandible to simulate the mandible without the 

lesion (Neomandible). This object can be later 3D 

Printed for prebending of a reconstruction plate, or 

it can be used in the design of a Patient Specific 

Implant (PSI). 

● Using the “Offset” tool again, this time on the 

Mandible, a 3 mm thicker object can be created. 

Using the “Remove Undercut” tool, it is made to fit 

on the original mandibular body. It can be then cut 

using the offset lesion, and trimmed, creating the 

final Resection Guide. 

● The resection guide along with the model can then 

be exported in STL format. The exported STL file 

for the surgical guide is 3D-printed. 

 

3. Case Report 

A 50-year-old male with non-contributing medical 

history reported to the department of oral and maxillofacial 

surgery complaining of a facial swelling affecting left side of 

the face. The swelling was painless, with a gradual onset and 

a prolonged duration, and was first noticed 2 years earlier. A 

MSCT scan was ordered, and showed a multilocular, well-

defined radiolucent lesion in the left mandibular body and 

ramus, extending posterior to the left mental foramen, to the 

mandibular angle, and reaching the mid ramus. An incisional 

biopsy was taken for the lesion under local anesthesia via an 

intraoral approach, based on which, the lesion was diagnosed 

as a Central Giant Cell Lesion. Initially, conservative 

treatment was tried in the form of intra-lesional steroid 

injections and subcutaneous Calcitonin injections. A 3-

Months follow-up MSCT scan showed poor response with an 

increase in the lesion dimensions. The case was therefore 

planned for resection. The case was virtually planned using 

the Mimics Innovation Suite and 3-matic Medical softwares 

by Materialize as previously described with a safety margin 

of 5mm. The surgical guides and the mandibular model were 

3D printed. A reconstruction plate was prebent using the 

mandibular model. Access was carried out through a 

submandibular approach and the guides fixated on the 

mandible using miniscrews. The osteotomies were carried out 

using Piezotome, and the segments were fixed using the 

prebent reconstruction plate. The wound was then closed 

primarily. Patient recovery was uneventful (Figure 1). 

Figure 1: (A) Virtual model showing the mandible, (B) Virtual model showing the lesion, (C) Virtual model showing lesion with 

safety margin, (D) Virtual model showing designed resection guides, (E) 3D Printed mandibular model and resection guides, (F) 

Anterior guide fixed in place, (G) Posterior guide fixed in place, (H) Resection complete and segments fixated with prebent 

reconstruction plate. 
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4. Conclusion 

 

Non-linear mandibular resection guides may be effective in 

producing tumor-free margins, increasing bone preservation, 

and can be easy and inexpensive to produce. 
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